Promt

1. a cél ezekkel a fájlokkal, hogy készíts egy Excel (.xlsm formátumban) makrót, aminek a segítségével meg lehet mondani, hogy a .csv fájlok fájlonként hány sort tartalmaznak.

Oké, csináljunk egy olyan Excel makrót (.xlsm), ami:
· megkérdezi, melyik mappában vannak a .csv fájlok
· végigmegy az összes *.csv-n
· egy munkalapra kiírja:
· a fájl nevét
· hány sort tartalmaz (alapból minden sort beleszámol, fejlécestül)

1. Lépés: .xlsm fájl létrehozása
1. Nyisd meg az Excelt.
2. Hozz létre egy új munkafüzetet.
3. Mentsd el így:
· Fájl → Mentés másként
· Fájltípus: Excel makrókkal bővített munkafüzet (*.xlsm)
4. Nevezd mondjuk: CSV_sorok_szamlalo.xlsm
(Opcionálisan készíthetsz egy külön lapot pl. Eredmeny néven, de ha nem, az aktív lapot fogja használni.)

2. Lépés: VBA szerkesztő megnyitása
1. Nyomd meg: Alt + F11
2. A bal oldali Project ablakban válaszd ki a munkafüzetet (ahova mentettél).
3. Menü: Insert → Module (Új modul beszúrása)
A megnyíló üres modulba másold be az alábbi kódot:
Option Explicit

' Fő makró: mappa kiválasztása, fájlok bejárása, sorok számlálása
Sub CSV_Sorok_Szamlalasa()
    Dim fDialog As FileDialog
    Dim mappaUt As String
    Dim aktLap As Worksheet
    Dim fajlNev As String
    Dim teljesUt As String
    Dim sorSzam As Long
    Dim eredmenySor As Long
    
    ' Mappa kiválasztása
    Set fDialog = Application.FileDialog(msoFileDialogFolderPicker)
    With fDialog
        .Title = "Válaszd ki a mappát, ahol a .csv fájlok vannak"
        .AllowMultiSelect = False
        If .Show <> -1 Then
            MsgBox "Nem választottál mappát.", vbExclamation
            Exit Sub
        End If
        mappaUt = .SelectedItems(1)
    End With
    
    ' Aktív munkalapra írjunk
    Set aktLap = ActiveSheet
    
    ' Fejlécek kiírása
    aktLap.Cells.ClearContents
    aktLap.Range("A1").Value = "Fájlnév"
    aktLap.Range("B1").Value = "Sorok száma (.csv)"
    eredmenySor = 2
    
    ' Első .csv fájl a mappában
    fajlNev = Dir(mappaUt & Application.PathSeparator & "*.csv")
    
    If fajlNev = "" Then
        MsgBox "A kiválasztott mappában nincs egyetlen .csv fájl sem.", vbInformation
        Exit Sub
    End If
    
    Application.ScreenUpdating = False
    
    ' Végigmegyünk az összes .csv fájlon
    Do While fajlNev <> ""
        teljesUt = mappaUt & Application.PathSeparator & fajlNev
        
        ' Sorok számlálása
        sorSzam = SzamoldSorokSzamat(teljesUt)
        
        ' Eredmény kiírása
        aktLap.Cells(eredmenySor, 1).Value = fajlNev
        aktLap.Cells(eredmenySor, 2).Value = sorSzam
        
        eredmenySor = eredmenySor + 1
        
        ' Következő fájl
        fajlNev = Dir
    Loop
    
    Application.ScreenUpdating = True
    
    MsgBox "Kész! A sorok száma az aktív munkalapon látható.", vbInformation
End Sub

' Segédfüggvény: megszámolja, hány sor van egy szöveges fájlban
Private Function SzamoldSorokSzamat(ByVal fajlUt As String) As Long
    Dim f As Integer
    Dim count As Long
    Dim egySor As String
    
    On Error GoTo HibaKezeles
    
    f = FreeFile
    Open fajlUt For Input As #f
    
    Do While Not EOF(f)
        Line Input #f, egySor
        count = count + 1
    Loop
    
    Close #f
    
    SzamoldSorokSzamat = count
    Exit Function
    
HibaKezeles:
    On Error Resume Next
    Close #f
    SzamoldSorokSzamat = -1   ' hiba esetén -1-et ad vissza
End Function

3. Lépés: Makró futtatása
1. Térj vissza az Excelhez (Alt + F11-el vagy az ablak váltásával).
2. Győződj meg róla, hogy azon a lapon állsz, ahova az eredményt szeretnéd (pl. Eredmeny).
3. Nyomd meg: Alt + F8
4. Válaszd ki: CSV_Sorok_Szamlalasa
5. Kattints: Futtatás (Run)
6. Felugrik egy ablak, ahol ki kell választanod a mappát, amiben a .csv fájlok vannak.
7. OK után a makró:
· letörli a lap tartalmát
· A1-be: Fájlnév, B1-be: Sorok száma (.csv)
· alatta soronként kilistázza a fájlokat és a sorok számát

Fejléc kezelése (ha a csv-knek van fejléc sora)
A jelenlegi verzió minden sort beleszámol, tehát a fejlécet is.
Ha azt szeretnéd, hogy a fejlécek ne számítsanak bele, akkor módosítsd itt a kódban:
Ebben a részben:
sorSzam = SzamoldSorokSzamat(teljesUt)
cseréld erre:
sorSzam = SzamoldSorokSzamat(teljesUt)

If sorSzam > 0 Then
    sorSzam = sorSzam - 1   ' fejléc kivonása
End If
(így ha van fejléc, az nem kerül bele a darabszámba).

Ha szeretnéd, a következő körben tudok hozzátenni egy gombot a munkalapra, ami egy kattintással futtatja ezt a makrót, vagy tudjuk úgy módosítani, hogy al-mappákban lévő .csv-ket is beleszámolja.

2. ezt írd át úgy hogy Mac-en is meg tudjam csinálni

Oké, csináljunk belőle Mac-en is biztosan használható verziót.
A trükk: ne használjunk Windows-specifikus \ elválasztót, hanem okosan kezeljük a \ / / kérdést, a többi ugyanúgy működik Mac alatt is.

1. Lépés: .xlsm fájl létrehozása Mac-en
1. Nyisd meg az Excel for Mac-et.
2. Új munkafüzet.
3. File → Save As… (Mentés másként)
4. File Format / Fájltípus:
· Excel Macro-Enabled Workbook (*.xlsm)
5. Adj neki nevet, pl. CSV_sorok_szamlalo.xlsm.

2. Lépés: VBA szerkesztő megnyitása Mac-en
· Menü: Tools → Macro → Visual Basic Editor
(vagy billentyű: gyakran Option + F11 vagy Fn + Option + F11, géptől függően)
A bal oldali Project ablakban válaszd ki az imént mentett munkafüzetet, majd:
· Insert → Module
Az üres modulba másold be EZT az átdolgozott kódot:
Option Explicit

' Fő makró: mappa kiválasztása, fájlok bejárása, sorok számlálása
Sub CSV_Sorok_Szamlalasa()
    Dim fDialog As FileDialog
    Dim mappaUt As String
    Dim aktLap As Worksheet
    Dim fajlNev As String
    Dim teljesUt As String
    Dim sorSzam As Long
    Dim eredmenySor As Long
    
    ' Mappa kiválasztása (Mac-en is megy)
    Set fDialog = Application.FileDialog(msoFileDialogFolderPicker)
    With fDialog
        .Title = "Válaszd ki a mappát, ahol a .csv fájlok vannak"
        .AllowMultiSelect = False
        If .Show <> -1 Then
            MsgBox "Nem választottál mappát.", vbExclamation
            Exit Sub
        End If
        mappaUt = .SelectedItems(1)
    End With
    
    ' Aktív munkalapra írjunk
    Set aktLap = ActiveSheet
    
    ' Fejlécek kiírása
    aktLap.Cells.ClearContents
    aktLap.Range("A1").Value = "Fájlnév"
    aktLap.Range("B1").Value = "Sorok száma (.csv)"
    eredmenySor = 2
    
    ' Első .csv fájl a mappában
    fajlNev = Dir(OsszefuzPath(mappaUt, "*.csv"))
    
    If fajlNev = "" Then
        MsgBox "A kiválasztott mappában nincs egyetlen .csv fájl sem.", vbInformation
        Exit Sub
    End If
    
    Application.ScreenUpdating = False
    
    ' Végigmegyünk az összes .csv fájlon
    Do While fajlNev <> ""
        teljesUt = OsszefuzPath(mappaUt, fajlNev)
        
        ' Sorok számlálása
        sorSzam = SzamoldSorokSzamat(teljesUt)
        
        ' Ha fejlécet NEM akarod beleszámolni, ezt a két sort vedd ki kommentből:
        'If sorSzam > 0 Then
        '    sorSzam = sorSzam - 1
        'End If
        
        ' Eredmény kiírása
        aktLap.Cells(eredmenySor, 1).Value = fajlNev
        aktLap.Cells(eredmenySor, 2).Value = sorSzam
        
        eredmenySor = eredmenySor + 1
        
        ' Következő fájl
        fajlNev = Dir
    Loop
    
    Application.ScreenUpdating = True
    
    MsgBox "Kész! A sorok száma az aktív munkalapon látható.", vbInformation
End Sub

' Segédfüggvény: megszámolja, hány sor van egy szöveges fájlban
Private Function SzamoldSorokSzamat(ByVal fajlUt As String) As Long
    Dim f As Integer
    Dim count As Long
    Dim egySor As String
    
    On Error GoTo HibaKezeles
    
    f = FreeFile
    Open fajlUt For Input As #f
    
    Do While Not EOF(f)
        Line Input #f, egySor
        count = count + 1
    Loop
    
    Close #f
    
    SzamoldSorokSzamat = count
    Exit Function
    
HibaKezeles:
    On Error Resume Next
    Close #f
    SzamoldSorokSzamat = -1   ' hiba esetén -1-et ad vissza
End Function

' Útvonal összefűzés Mac + Windows kompatibilisen
Private Function OsszefuzPath(ByVal folderPath As String, ByVal fileName As String) As String
    Dim sep As String
    
    ' Ha már / vagy \ a vége, nem kell elválasztó
    If Right(folderPath, 1) = "\" Or Right(folderPath, 1) = "/" Then
        sep = ""
    ElseIf InStr(folderPath, "/") > 0 Then
        ' Ha a path-ban / van, akkor /-t használunk (Mac, vagy Windows POSIX jellegű path)
        sep = "/"
    Else
        ' Egyébként \ (klasszikus Windows)
        sep = "\"
    End If
    
    OsszefuzPath = folderPath & sep & fileName
End Function

3. Lépés: Makró futtatása Mac-en
1. Térj vissza az Excel ablakhoz.
2. Állj arra a munkalapra, ahova az eredményt szeretnéd.
3. Menü: Tools → Macro → Macros…
4. Válaszd ki: CSV_Sorok_Szamlalasa
5. Run (Futtatás).
6. Felugrik a mappaválasztó ablak – válaszd ki azt a mappát, ahol a .csv-k vannak.
Ezután a makró:
· törli az aktív lap tartalmát,
· A1: Fájlnév, B1: Sorok száma (.csv),
· alatta soronként: fájlnév + sorok száma.

Fejléc kizárása (ha a .csv fájloknak van fejléce)
A kódban már ott a rész, csak ki van kommentelve:
'If sorSzam > 0 Then
'    sorSzam = sorSzam - 1
'End If
Ha nem szeretnéd beleszámolni a fejlécet, csak vedd ki az elejükről az aposztrófot ('), hogy így nézzen ki:
If sorSzam > 0 Then
    sorSzam = sorSzam - 1
End If

Ha elakadsz valamelyik konkrét Mac-es menüponttal (melyik Excel verzió, hol a Developer tab stb.), írd meg, és ahhoz is adok külön, verzió-specifikus lépéseket.
3. a makró beírása és futtatása után Run-time 91: Objects variable not set

Szuper, hogy leírtad a hibát – a Run-time error '91': Object variable or With block variable not set szinte biztosan onnan jön, hogy a FileDialog (mappa-választó ablak) Mac-en nálad épp nem működik, és az fDialog objektum Nothing, ezért amikor .Title = ...-hez ér a kód, elszáll.
A legegyszerűbb megoldás: kidobjuk a FileDialog-ot, és helyette egy sima szöveges beviteli ablakból (InputBox)kérjük be a mappa elérési útját. Ez mindenhol működik: Mac-en, Windowson is.
Az alábbi kód már nem használ FileDialog-ot, így a 91-es hiba el fog tűnni. 👇

ÚJ, javított makró (Mac + Windows, FileDialog nélkül)
1. Nyisd meg a VBA editort (Alt+F11 / Tools → Macro → Visual Basic).
2. A modulban töröld a régi kódot, és másold be ezt:
Option Explicit

' Fő makró: mappa elérési útjának bekérése, fájlok bejárása, sorok számlálása
Sub CSV_Sorok_Szamlalasa()
    Dim mappaUt As String
    Dim aktLap As Worksheet
    Dim fajlNev As String
    Dim teljesUt As String
    Dim sorSzam As Long
    Dim eredmenySor As Long
    
    ' Mappa elérési útjának bekérése
    ' Pl. Mac-en így nézhet ki: /Volumes/adatok/csvk
    ' Windows-on: Z:\csvk vagy C:\csvk
    mappaUt = Application.InputBox( _
        Prompt:="Add meg a mappa elérési útját, ahol a .csv fájlok vannak:" & vbCrLf & vbCrLf & _
                "Példák:" & vbCrLf & _
                "  Mac: /Volumes/adatok/csvk" & vbCrLf & _
                "  Win: Z:\csvk", _
        Title:="Mappa elérési útja", _
        Type:=2)   ' Type:=2 = szöveg

    ' Ha a felhasználó mégsem adott meg semmit (Cancel vagy üres), lépjünk ki
    If mappaUt = "False" Or Trim(mappaUt) = "" Then
        MsgBox "Nem adtál meg mappa elérési útját.", vbExclamation
        Exit Sub
    End If
    
    ' Aktív munkalapra írjunk
    Set aktLap = ActiveSheet
    
    ' Fejlécek kiírása
    aktLap.Cells.ClearContents
    aktLap.Range("A1").Value = "Fájlnév"
    aktLap.Range("B1").Value = "Sorok száma (.csv)"
    eredmenySor = 2
    
    ' Első .csv fájl a mappában
    fajlNev = Dir(OsszefuzPath(mappaUt, "*.csv"))
    
    If fajlNev = "" Then
        MsgBox "A megadott mappában nincs egyetlen .csv fájl sem.", vbInformation
        Exit Sub
    End If
    
    Application.ScreenUpdating = False
    
    ' Végigmegyünk az összes .csv fájlon
    Do While fajlNev <> ""
        teljesUt = OsszefuzPath(mappaUt, fajlNev)
        
        ' Sorok számlálása
        sorSzam = SzamoldSorokSzamat(teljesUt)
        
        ' Ha a fejlécet NEM akarod beleszámolni, akkor vedd ki kommentből ezt:
        'If sorSzam > 0 Then
        '    sorSzam = sorSzam - 1
        'End If
        
        ' Eredmény kiírása
        aktLap.Cells(eredmenySor, 1).Value = fajlNev
        aktLap.Cells(eredmenySor, 2).Value = sorSzam
        
        eredmenySor = eredmenySor + 1
        
        ' Következő fájl
        fajlNev = Dir
    Loop
    
    Application.ScreenUpdating = True
    
    MsgBox "Kész! A sorok száma az aktív munkalapon látható.", vbInformation
End Sub

' Segédfüggvény: megszámolja, hány sor van egy szöveges fájlban
Private Function SzamoldSorokSzamat(ByVal fajlUt As String) As Long
    Dim f As Integer
    Dim count As Long
    Dim egySor As String
    
    On Error GoTo HibaKezeles
    
    f = FreeFile
    Open fajlUt For Input As #f
    
    Do While Not EOF(f)
        Line Input #f, egySor
        count = count + 1
    Loop
    
    Close #f
    
    SzamoldSorokSzamat = count
    Exit Function
    
HibaKezeles:
    On Error Resume Next
    Close #f
    SzamoldSorokSzamat = -1   ' hiba esetén -1-et ad vissza
End Function

' Útvonal összefűzés Mac + Windows kompatibilisen
Private Function OsszefuzPath(ByVal folderPath As String, ByVal fileName As String) As String
    Dim sep As String
    
    folderPath = Trim(folderPath)
    
    ' Ha már / vagy \ a vége, nem kell elválasztó
    If Right(folderPath, 1) = "\" Or Right(folderPath, 1) = "/" Then
        sep = ""
    ElseIf InStr(folderPath, "/") > 0 Then
        ' Ha a path-ban / van, akkor /-t használunk (Mac, vagy POSIX jellegű path)
        sep = "/"
    Else
        ' Egyébként \ (klasszikus Windows)
        sep = "\"
    End If
    
    OsszefuzPath = folderPath & sep & fileName
End Function

Hogyan használd ezt most?
1. Futtasd a makrót (Alt+F8 → CSV_Sorok_Szamlalasa → Run).
2. Felugrik egy ablak, ahol be kell írnod a mappa elérési útját.
· Mac-en, ha a szerver-mappa fel van csatolva, ilyesmi lesz pl.:
· /Volumes/megosztas_neve/csv_konyvtar
· Windows-on pl.:
· Z:\csv_konyvtar
3. OK után a makró:
· törli az aktuális lap tartalmát,
· A1: Fájlnév, B1: Sorok száma (.csv),
· alatta listázza a fájlokat és a sorok számát.

Kis tipp Mac-en: hogyan szerzed meg a pontos elérési utat?
Pár praktikus módszer:
· Terminálból:
· Finderben menj a mappára, jobb klikk → Copy "folder" as Pathname (ha van ilyen), majd beilleszted az InputBox-ba.
· Vagy nyiss Terminalt, húzd bele a mappát, és a path megjelenik — onnan kimásolod.
· Ha a szerver SMB megosztásként csatlakozik (Cmd+K → smb://...), akkor a path tipikusan /Volumes/valami lesz.

Miért tűnik el most a Run-time 91?
Mert:
· már nem használunk FileDialog objektumot, ami Mac-en nálad valószínűleg Nothing volt,
· az InputBox viszont mindig ad vissza valamit (szöveg vagy "False"), és ezt lekezeljük.
Ha még mindig hibát kapsz, írd le, melyik sor sárgul be, amikor megnyomod a „Debug / Hibakeresés” gombot – de nagyon valószínű, hogy ezzel a verzióval már simán végigfut.
4. "a fájlban nincs egyetlen .csv fájl sem" üzenetet kapom. Pedig benne vannak

Szupi, ez egy tipikus Mac-es „apróság”, és nem te rontottad el. 🙂
Az üzenet azért jön, mert a Dir(...) valójában nem találja a fájlokat – általában azért, mert az elérési út nem pont úgy néz ki, ahogy a VBA várja.
A leggyakoribb ok Mac-en:
Finderből / Terminalból másolva az elérési út idézőjelek között van, pl.:
" /Volumes/szerver/csv_konyvtar "
(valójában: "/Volumes/szerver/csv_konyvtar")
Ilyenkor a VBA a " karaktereket is beleteszi az útvonalba, és így természetesen nem talál semmit.

1. Javítsuk a kódban: szedjük le az idézőjeleket
Csak a makró elején, a mappaUt = Application.InputBox(...) után kell pár sort hozzáadni.
Keresd meg ezt a részt:
mappaUt = Application.InputBox( _
    Prompt:="Add meg a mappa elérési útját, ahol a .csv fájlok vannak:" & vbCrLf & vbCrLf & _
            "Példák:" & vbCrLf & _
            "  Mac: /Volumes/adatok/csvk" & vbCrLf & _
            "  Win: Z:\csvk", _
    Title:="Mappa elérési útja", _
    Type:=2)   ' Type:=2 = szöveg

' Ha a felhasználó mégsem adott meg semmit (Cancel vagy üres), lépjünk ki
If mappaUt = "False" Or Trim(mappaUt) = "" Then
    MsgBox "Nem adtál meg mappa elérési útját.", vbExclamation
    Exit Sub
End If
És utána tedd be ezt a részt:
Dim p As String

p = CStr(mappaUt)
p = Trim(p)

' Ha az útvonal elején és végén is idézőjel van, vágjuk le
If Left(p, 1) = """" And Right(p, 1) = """" Then
    p = Mid(p, 2, Len(p) - 2)
End If

mappaUt = p
Tehát a blokk így fog kinézni egyben:
mappaUt = Application.InputBox( _
    Prompt:="Add meg a mappa elérési útját, ahol a .csv fájlok vannak:" & vbCrLf & vbCrLf & _
            "Példák:" & vbCrLf & _
            "  Mac: /Volumes/adatok/csvk" & vbCrLf & _
            "  Win: Z:\csvk", _
    Title:="Mappa elérési útja", _
    Type:=2)   ' Type:=2 = szöveg

If mappaUt = "False" Or Trim(mappaUt) = "" Then
    MsgBox "Nem adtál meg mappa elérési útját.", vbExclamation
    Exit Sub
End If

Dim p As String
p = CStr(mappaUt)
p = Trim(p)

If Left(p, 1) = """" And Right(p, 1) = """" Then
    p = Mid(p, 2, Len(p) - 2)
End If

mappaUt = p

2. Egy gyors ellenőrzés: mit lát a Dir?
Ha szeretnél „rálesni”, hogy pontosan milyen útvonalat rak össze, ideiglenesen betehetsz egy ilyen sort:
MsgBox "Ezt az útvonalat használom: " & OsszefuzPath(mappaUt, "*.csv")
Közvetlenül az elé, hogy:
fajlNev = Dir(OsszefuzPath(mappaUt, "*.csv"))
Ha a felugró ablakban látod az útvonalat, és az jól néz ki (pl. /Volumes/szerver/share/csvk/*.csv), akkor már jó úton vagyunk.

3. Még két gyors dolog, ami gond lehet
Ha ezután is azt mondja, hogy nincs .csv:
1. Biztosan mappát adtál meg, nem fájlt?
· pl. jó: /Volumes/szerver/share/csvk
· nem jó: /Volumes/szerver/share/csvk/adat.csv
2. A kiterjesztés tényleg .csv?
· Nem .CSV vagy .txt?
· Általában ez sem gond, de ha nagyon makacs, átmenetileg kipróbálhatod:
· fajlNev = Dir(OsszefuzPath(mappaUt, "*.*"))
csak próbaképp, hogy egyáltalán lát-e bármit a mappában.

Ha szeretnéd, megírhatom a teljes makrót újra egyben a módosításokkal, hogy csak be kelljen copy–paste-elni, de első körben próbáld ki az idézőjellevágós kiegészítést – 10-ből 9-szer ez oldja meg azt, amit most tapasztalsz.
5. írd meg a teljes makrót és azt is hogy utána milyen elérési úttal tudom megnyitni a fájlt

Oké, rakjuk össze az egészet tisztán, egyben. 😊
Először megkapod a teljes, bemásolható makrót, utána megmutatom, pontosan milyen elérési utat írj be Mac-en.

1. Teljes makró (másold be egy modulba)
1. Nyisd meg az Excelt.
2. Nyisd meg / hozd létre a valami.xlsm fájlt.
3. Alt+F11 (vagy Tools → Macro → Visual Basic).
4. Bal oldalt a projektben: jobb klikk Modules → Insert → Module.
5. A jobb oldali üres részbe teljesen így másold be:
Option Explicit

' Fő makró: mappa elérési útjának bekérése, .csv fájlok bejárása, sorok számlálása
Sub CSV_Sorok_Szamlalasa()
    Dim mappaUt As String
    Dim aktLap As Worksheet
    Dim fajlNev As String
    Dim teljesUt As String
    Dim sorSzam As Long
    Dim eredmenySor As Long
    Dim p As String

    ' --- 1) Mappa elérési útjának bekérése ---

    mappaUt = Application.InputBox( _
        Prompt:="Add meg a mappa elérési útját, ahol a .csv fájlok vannak:" & vbCrLf & vbCrLf & _
                "Példák:" & vbCrLf & _
                "  Mac:  /Volumes/adatok/csvk" & vbCrLf & _
                "  Win:  Z:\csvk", _
        Title:="Mappa elérési útja", _
        Type:=2)   ' Type:=2 = szöveg

    ' Cancel vagy üres eset
    If mappaUt = "False" Or Trim(mappaUt) = "" Then
        MsgBox "Nem adtál meg mappa elérési útját.", vbExclamation
        Exit Sub
    End If

    ' --- 2) Elérési út tisztítása (felesleges idézőjelek levágása) ---

    p = CStr(mappaUt)
    p = Trim(p)

    ' Ha az út elején ÉS végén is idézőjel van, vágjuk le
    If Left(p, 1) = """" And Right(p, 1) = """" Then
        p = Mid(p, 2, Len(p) - 2)
    End If

    mappaUt = p

    ' --- 3) Aktív munkalap előkészítése ---

    Set aktLap = ActiveSheet
    aktLap.Cells.ClearContents

    aktLap.Range("A1").Value = "Fájlnév"
    aktLap.Range("B1").Value = "Sorok száma (.csv)"
    eredmenySor = 2

    ' --- 4) Első .csv fájl keresése a mappában ---

    fajlNev = Dir(OsszefuzPath(mappaUt, "*.csv"))

    If fajlNev = "" Then
        MsgBox "A megadott mappában nincs egyetlen .csv fájl sem.", vbInformation
        Exit Sub
    End If

    Application.ScreenUpdating = False

    ' --- 5) Végigmegyünk az összes .csv fájlon ---

    Do While fajlNev <> ""
        teljesUt = OsszefuzPath(mappaUt, fajlNev)

        ' Sorok számlálása a fájlban
        sorSzam = SzamoldSorokSzamat(teljesUt)

        ' Ha a fejlécet NEM szeretnéd beleszámolni, akkor ezt vedd ki kommentből:
        'If sorSzam > 0 Then
        '    sorSzam = sorSzam - 1
        'End If

        ' Eredmény kiírása
        aktLap.Cells(eredmenySor, 1).Value = fajlNev
        aktLap.Cells(eredmenySor, 2).Value = sorSzam

        eredmenySor = eredmenySor + 1

        ' Következő fájl
        fajlNev = Dir
    Loop

    Application.ScreenUpdating = True

    MsgBox "Kész! A sorok száma az aktív munkalapon látható.", vbInformation
End Sub


' Segédfüggvény: megszámolja, hány sor van egy szöveges (.csv) fájlban
Private Function SzamoldSorokSzamat(ByVal fajlUt As String) As Long
    Dim f As Integer
    Dim count As Long
    Dim egySor As String

    On Error GoTo HibaKezeles

    f = FreeFile
    Open fajlUt For Input As #f

    Do While Not EOF(f)
        Line Input #f, egySor
        count = count + 1
    Loop

    Close #f

    SzamoldSorokSzamat = count
    Exit Function

HibaKezeles:
    On Error Resume Next
    Close #f
    SzamoldSorokSzamat = -1   ' hiba esetén -1-et ad vissza
End Function


' Útvonal összefűzés Mac + Windows kompatibilisen
Private Function OsszefuzPath(ByVal folderPath As String, ByVal fileName As String) As String
    Dim sep As String

    folderPath = Trim(folderPath)

    ' Ha már / vagy \ a vége, nem kell elválasztó
    If Right(folderPath, 1) = "\" Or Right(folderPath, 1) = "/" Then
        sep = ""
    ElseIf InStr(folderPath, "/") > 0 Then
        ' Ha a path-ban / van, akkor /-t használunk (Mac, vagy POSIX jellegű path)
        sep = "/"
    Else
        ' Egyébként \ (klasszikus Windows)
        sep = "\"
    End If

    OsszefuzPath = folderPath & sep & fileName
End Function
6. Mentsd el a munkafüzetet úgy, hogy makrókkal bővített maradjon:
Fájl → Mentés másként → Excel Macro-Enabled Workbook (*.xlsm)

2. Makró futtatása
1. Nyisd meg az .xlsm fájlt.
2. Menj arra a munkalapra, ahova szeretnéd az eredményt.
3. Alt + F8 (vagy Mac-en: Tools → Macro → Macros…).
4. Válaszd ki: CSV_Sorok_Szamlalasa.
5. Katt: Run / Futtatás.
6. Felugrik egy ablak, ahol be kell írnod a mappa elérési útját.
Na, és akkor jön a fő kérdésed:

3. Milyen elérési utat írjak be Mac-en?
A makró mappát vár, nem fájlt.
Tehát azt a mappát kell megadnod, amiben a .csv fájlok vannak.
3.1. Hogy szerzed meg az elérési utat a Finderből?
Legpraktikusabb módszer:
1. Finderben keresd meg azt a mappát, ahol a .csv-k vannak.
2. Jelöld ki a mappát.
3. Nyomd meg: Cmd + Option + C
→ ezzel a teljes fájlrendszerbeli útvonal kerül a vágólapra.
4. Menj vissza az Excelben a felugró InputBox-hoz és Cmd + V-vel illeszd be.
Példa, amit látni fogsz:
/Users/te/Projects/csvk
vagy ha ez egy felcsatolt szerver-megosztás:
/Volumes/szervermegosztas/csvk
Ezt kell beírnod / beillesztened.
Ha Finderben „Copy as Pathname”-et használsz, előfordul, hogy az útvonal idézőjelek között lesz ("/Volumes/...").
Erre raktuk be a kódban az idézőjel-levágó részt, szóval azt is lekezeli.

3.2. Tipikus példák elérési útra
1️⃣ Helyi mappa a saját gépeden
A .csv-k mondjuk itt vannak: Dokumentumok → Projekt → csvk
A path valószínűleg ilyesmi:
/Users/a_te_felhasznaloneved/Documents/Projekt/csvk
Ezt írod az InputBox-ba.

2️⃣ Szerver, amit hálózati megosztásként csatoltál fel (smb)
Ha Finderben így csatlakoztál:
· Menü: Go → Connect to Server… (Cmd + K)
· címsor: smb://szervernev/megosztas
és utána a megosztás Locations alatt megjelenik, és azon belül van egy csvk mappa, akkor az útvonal általában ilyen lesz:
/Volumes/megosztas/csvk
Pontosan kideríteni:
1. Finderben jelöld ki a csvk mappát.
2. Cmd + Option + C.
3. Excel InputBox-ba beilleszted.

3️⃣ Ha Terminalból húzod be
1. Nyisd meg a Terminal-t.
2. Húzd bele Finderből a mappát, ahol a .csv-k vannak.
3. Ott megjelenik valami ilyesmi:
/Volumes/megosztas/csvk
Ezt másold, és az Excel makró InputBox-ába illeszd.

4. A makró mit fog csinálni?
Ha az elérési út jó, akkor:
· törli az aktív munkalap tartalmát,
· A1-be írja: Fájlnév,
· B1-be: Sorok száma (.csv),
· alatta soronként:
· A oszlop: a .csv fájl neve,
· B oszlop: abban a fájlban lévő sorok száma.
Ha a .csv-knek van fejléc sora és nem akarod beleszámolni, akkor a kódban ezt a 3 sort vedd ki kommentből:
'If sorSzam > 0 Then
'    sorSzam = sorSzam - 1
'End If
és legyen így:
If sorSzam > 0 Then
    sorSzam = sorSzam - 1
End If

Ha legközelebb még mindig azt írja, hogy „nincs .csv fájl”, küldheted nekem konkrétan, hogy milyen elérési utat írtál be(nyugodtan bemásolhatod ide szövegként), és ránézek, mi lehet benne a buktató.




Makró


Option Explicit

' Fő makró: mappa elérési útjának bekérése, .csv fájlok bejárása, sorok számlálása
Sub CSV_Sorok_Szamlalasa()
    Dim mappaUt As String
    Dim aktLap As Worksheet
    Dim fajlNev As String
    Dim teljesUt As String
    Dim sorSzam As Long
    Dim eredmenySor As Long
    Dim p As String

    ' --- 1) Mappa elérési útjának bekérése ---

    mappaUt = Application.InputBox( _
        Prompt:="Add meg a mappa elérési útját, ahol a .csv fájlok vannak:" & vbCrLf & vbCrLf & _
                "Példák:" & vbCrLf & _
                "  Mac:  /Volumes/adatok/csvk" & vbCrLf & _
                "  Win:  Z:\csvk", _
        Title:="Mappa elérési útja", _
        Type:=2)   ' Type:=2 = szöveg

    ' Cancel vagy üres eset
    If mappaUt = "False" Or Trim(mappaUt) = "" Then
        MsgBox "Nem adtál meg mappa elérési útját.", vbExclamation
        Exit Sub
    End If

    ' --- 2) Elérési út tisztítása (felesleges idézőjelek levágása) ---

    p = CStr(mappaUt)
    p = Trim(p)

    ' Ha az út elején ÉS végén is idézőjel van, vágjuk le
    If Left(p, 1) = """" And Right(p, 1) = """" Then
        p = Mid(p, 2, Len(p) - 2)
    End If

    mappaUt = p

    ' --- 3) Aktív munkalap előkészítése ---

    Set aktLap = ActiveSheet
    aktLap.Cells.ClearContents

    aktLap.Range("A1").Value = "Fájlnév"
    aktLap.Range("B1").Value = "Sorok száma (.csv)"
    eredmenySor = 2

    ' --- 4) Első .csv fájl keresése a mappában ---

    fajlNev = Dir(OsszefuzPath(mappaUt, "*.csv"))

    If fajlNev = "" Then
        MsgBox "A megadott mappában nincs egyetlen .csv fájl sem.", vbInformation
        Exit Sub
    End If

    Application.ScreenUpdating = False

    ' --- 5) Végigmegyünk az összes .csv fájlon ---

    Do While fajlNev <> ""
        teljesUt = OsszefuzPath(mappaUt, fajlNev)

        ' Sorok számlálása a fájlban
        sorSzam = SzamoldSorokSzamat(teljesUt)

        ' Ha a fejlécet NEM szeretnéd beleszámolni, akkor ezt vedd ki kommentből:
        'If sorSzam > 0 Then
        '    sorSzam = sorSzam - 1
        'End If

        ' Eredmény kiírása
        aktLap.Cells(eredmenySor, 1).Value = fajlNev
        aktLap.Cells(eredmenySor, 2).Value = sorSzam

        eredmenySor = eredmenySor + 1

        ' Következő fájl
        fajlNev = Dir
    Loop

    Application.ScreenUpdating = True

    MsgBox "Kész! A sorok száma az aktív munkalapon látható.", vbInformation
End Sub


' Segédfüggvény: megszámolja, hány sor van egy szöveges (.csv) fájlban
Private Function SzamoldSorokSzamat(ByVal fajlUt As String) As Long
    Dim f As Integer
    Dim count As Long
    Dim egySor As String

    On Error GoTo HibaKezeles

    f = FreeFile
    Open fajlUt For Input As #f

    Do While Not EOF(f)
        Line Input #f, egySor
        count = count + 1
    Loop

    Close #f

    SzamoldSorokSzamat = count
    Exit Function

HibaKezeles:
    On Error Resume Next
    Close #f
    SzamoldSorokSzamat = -1   ' hiba esetén -1-et ad vissza
End Function


' Útvonal összefűzés Mac + Windows kompatibilisen
Private Function OsszefuzPath(ByVal folderPath As String, ByVal fileName As String) As String
    Dim sep As String

    folderPath = Trim(folderPath)

    ' Ha már / vagy \ a vége, nem kell elválasztó
    If Right(folderPath, 1) = "\" Or Right(folderPath, 1) = "/" Then
        sep = ""
    ElseIf InStr(folderPath, "/") > 0 Then
        ' Ha a path-ban / van, akkor /-t használunk (Mac, vagy POSIX jellegű path)
        sep = "/"
    Else
        ' Egyébként \ (klasszikus Windows)
        sep = "\"
    End If

    OsszefuzPath = folderPath & sep & fileName
End Function



Eredmény: 
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